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Scope 
The MLX90129 from Melexis is a sensor IC with an integrated 13.56 MHz high frequency (HF) interface 
that allows sensor data to be read with a HF radio frequency identification (RFID) reader. The DVK90129 
is a development kit designed to assist developers explore the features of the MLX90129. 
 
This user manual provides guidelines for use of the DVK90129 development kit. It also provides 
guidelines for the EVB90129 datalogger / sensor tag based on the Melexis 90129 sensor IC and the 
Proxima RF USB HF RFID Desktop reader. The DVK90129 development kit along with user friendly 
evaluation software will decrease sensor IC evaluation time to improve your development cycle and time 
to market. The dedicated Application Programming Interface (API) provides a quick start for developing 
custom applications.  
 

Related Melexis Products 
Part No. Comments 

MLX90129 Sensor tag / RFID datalogger IC 

EVB90129 Evaluation Board for MLX90129 

DVK90129 Development kit for MLX90129 

 
 
 
 
 
 

 
  

Introduction 
The DVK90129 development kit has been 
developed by Melexis in partnership with 
Proxima RF. It provides a unique platform to 
evaluate and develop applications based on the 
MLX90129 sensor IC. By following the 
guidelines provided in this manual, the sensor 
tag and datalogging application can be 
implemented very quickly. The plug and play 
Proxima RF™ USB HF RFID reader and 
application oriented user interface are 
customized for the EVB91029 evaluation board. 
Pre-programmed settings for the EVB90129 
sensors along with external memory help 
developers discover and apply features found in 
the MLX90129 sensor IC. The XML based 
configuration file and export tools allow users to 
characterize the sensors and fine tune the 
MLX90129 settings and share these settings 
with other users. This documentation gives 
instructions for software and USB reader 
installation plus    guidance on features found in 
the evaluation software to help developers 
practice with the tools. Finally, step-by-step    
instructions are given for two examples so 
developers can walkthrough trial applications. 
The first example is based on a sensor tag 
application and the second example is based on 
a datalogging application.    
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1.Kit contents 
The DVK90129 is composed of: 
 

� Proxima RF™ Desktop reader  

         

� EVB90129 
          

             
 
Documentation, drivers, software and API are available with log in on the www.proximarf.com website. 
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2.Software and hardware installation 
The followings paragraphs describe how to download and install the user interface software and 
hardware. 

2.1. Download 

In order to download the software you must first create an account with Proxima RF. Please go to 
http://www.proximarf.com/support and find the New Customer tab on the page. Once you go to the New 
Customer page, see the picture of the serial number on the backplate of the reader. Note the serial 
number on your reader, fill in that number and click on ‘Sign Up’ to proceed with account creation. 
Complete account creation by providing the necessary contact information as requested. This information 
is necessary for product support and to contact you about updates. Once you have created an account, 
you can access the support page. The DVK90129 software will be available for download in the 
‘Downloads’ section. Be sure to select the correct software for your operating system.  

2.2. Software installation 

After downloading the software, simply run the installer and follow the on-screen instructions. The installer 
will install both the software and required drivers. 

2.3. Hardware installation 

2.3.1. Connect the Proxima RF Desktop 

Once the software and drivers are installed you can connect the Proxima RF Desktop reader to your 
computer using the enclosed USB cable. After connecting the USB Cable, please wait while Windows 
completes the hardware installation. A pop up screen will advise ‘Your new hardware is installed and 
ready to use’ to indicate that the Proxima RF Desktop unit is properly installed. 
 

2.3.2. Check the assigned Virtual COM Port 

IMPORTANT:  
Make sure that Windows has assigned a virtual com port between COM0 and COM9 to the Proxima RF 
Desktop by following these steps: 
- Navigate to ‘Start->Control Panel->System’.  
- Select the ‘Hardware’ tab and click on ‘Device Manager’.  
- Find the ‘Ports’ entry in the list of hardware and expand it by clicking on the ‘+’.  
- Find the ‘USB Serial Port (COMX)’ entry where X is the assigned number.  
 
If this number is not between 0 and 9 you can change this by following these steps: (NOTE: you must 
have administrative access on your computer to complete the next steps.) 
- Double click on the ‘USB Serial Port (COMX)’ entry 
- Select the ‘Port Settings’ tab. 
- Click on ‘Advanced’ 
- Select a new COM Port between COM0 and COM9 from the ‘COM Port Number’ list. 
- Click on ‘OK’ 
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3.Getting Started 

3.1.  Open the software 

Once the software is installed and the reader is connected, the DVK90129 User Interface can be started 
by navigating to Start->All Programs->Proxima RF->DVK90129 
 

3.2. New Project 

Start a new MLX90129 project by selecting 
“New” in the “File” menu. The project file 
contains the complete MLX90129 configuration 
in XML format. This configuration can be loaded 
in the software and in the MLX90129 memory. 
Save the project by selecting “Save” or “Save 
As” in the “File” menu. 
 

3.3. MLX90129 memory configuration 

Several tabs allow you to modify the 
configuration of the MLX90129 for both the 
datalogger and sensor tag. More information is 
provided in the following paragraphs. You can 
make as many modifications and changes as 
you like – they are only loaded in the software 
and will not be loaded to the device until you 
select “load configuration” – as follows.   

3.4. Load configuration 

Once you have finalized the configuration of the 
MLX90129. it can be loaded onto the EVB90129 
by RFID. Loading the configuration will modify 
the existing EEPROM and internal device 
configuration of the EVB90129. In order to 
proceed, the EVB90129 has to be placed on the 
top of the reader and click on the command 
“Load to MLX90129” in the Project menu.  

 
 
 

 
 

3.5. Run Application  

The sensor values collected from either the 
sensor tag or datalogging application can be 
seen through the “Sensor Tag Application” and 
“Datalogger Application” tabs. Data can be 
saved in CSV format.   
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4.Tabs description  
 
The following paragraphs describe the features of each tab. 

4.1. RFID configuration  

You can select ISO15693 communications modes via the “RFID Configuration” tab. This tab also allows 
you to send ISO15693 RFID commands and custom MLX90129 commands. For more information about 
ISO15693 modes and commands, please refer to the MLX90129 datasheet and to the ISO web site 
www.iso.org.  
 
/!\ WARNING: Only an experienced MLX90129 user should be allowed to send ISO15693 and MLX90129 
commands . Incorrect manipulation or bad parameters could result in locking the MLX90129 chip.  
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4.2. Sensor configuration  

The “Sensor Configuration” tab allows you to configure up to three sensors differently. The “Sensor 
common configuration” contains settings which are applied to all the sensors. Examples of changes you 
can make are:  the value of the internal resistor can be selected or the MLX90129 low volt supply can be 
enabled. NOTE: The “regulator low volt operation” option is linked to bit 3 of the internal device #04 and 
the “Disconnect field supply” impacts bit 15 of the internal device #03. 
 
The configuration for sensor 0, sensor 1 or sensor 2 includes ADC, acquisition chain, thresholds and 
connections settings. Threshold value and offset are to be filled with hexadecimal data. Detailed 
information is provided in the datasheet. The preprogrammed configurations of the following EVB90129 
sensors are available by clicking on the dedicated buttons: 
 

� Internal temperature sensor 
� External temperature sensor 
� External trimmer sensor 
� External light sensor 
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4.3. Sensor Tag Application  

The “Sensor Tag Application” tab allows reading of the MLX90129 sensor IC values with HF RFID.  Setup 
allows you to select which sensor(s) are to be read and the time between two consecutive measurements. 
Data for each sensor are shown in the dedicated windows. Data can be saved in CSV format. 
  
 

 
 
The following picture shows the format of the .csv file. The file can be opened with Microsoft Excel. 
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4.4. Datalogger Application  

The “Datalogger Application” tab is comprised of two sub tabs which allow configuration of datalogger 
parameters and provides a read-out of datalogging results. 
 

4.4.1. Datalogger configuration 

The configuration tab defines all the parameters for a datalogging application. First, select the data to be 
saved (sensor 0, sensor 1, sensor 2 and timestamp).  
For each sensor used during the datalogging, take care to note the threshold parameters available in the 
tab “Sensor configuration”. If no threshold conditions are used, the three conditions have to be ticked as 
shown in the following picture: 
 

 
  
 
The destination of the data (sensors, values and timestamp) can be either to the MLX90129 internal 
memory or to optional SPI external memory. In both cases, the start address (hexadecimal value), the 
number of data (decimal value) and the period of measurement must be provided. The required memory 
area is calculated and provided (hexadecimal value).  
 
When using the internal memory, the start address is 0x29 in order to prevent overwriting the 
configuration data. Choose the clock source for the period, either the MLX90129 embedded oscillator 
(LFO) or the external oscillator (XLFO). 
 
When using the external memory, fill in the communication parameters in “External Memory 
Configuration” or click on the “EVB90129 External memory” button to apply the recommended settings for 
the external memory of the EVB90129. 
 
There are several options for datalogging: 

� The setting “enable stand by mode once ended” allows the unit to go into stand by mode (lowest 
power consumption) after completion of the datalogging cycle.  

� The option “enable data logging loop” automatically restarts the data logging cycle, overwriting the 
previous data.  

� The “disable automatic loading” option is linked to bit 7 of the internal device #03 (cf datasheet). 
 
There are two options to start data acquisition:  
 

� The option “As soon as the MLX90129 is powered” means bit 2 of the EEPROM#10 “automatic 
logging mode enable” is set to ‘1’. This means that as soon as the MLX90129 is powered, the 
configuration is loaded into the register file and the datalogging application starts.  

� The option “By RFID command” means bit 2 of the EEPROM#10 “automatic logging mode 
enabled” is set to ‘0’. This means that even if the MLX90129 is powered, the datalogging 
application does not start. To start it, it is necessary to set this bit to 1 in the Register File #10. 
This command is sent by pressing the button “start datalogging” in the “Application” tab. 
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4.4.2. Datalogger application 

The datalogger application tab allows you to collect, display and save data logged from the MLX90129.   
Start the datalogging application by sending the command “Start Datalogging”. At any time the 
measurement sequence can be put on hold by pressing the button “Hold datalogging”. Finally, the 
application can be stopped by pressing the button “stop datalogging”. 
 
Data from sensors can be read and parsed in the three windows corresponding to sensor 0, 1 or 2. 
Values can be exported in a CSV file. The option “Visualize prefix” shows data as they are stored in 
memory, i.e. with a prefix. 
 
At any time during the sequence, you can read the current destination address which corresponds to 
internal     device #05. 
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4.5.  Memory Domain 

The “Memory Domain” tab is comprised of several sub tabs which correspond to the memory domain 
available in the MLX90129.  The memory domain is for displaying device configuration (MLX90129 
EEPROM / Register file / Internal device) and data storage (MLX90129 Internal EEPROM / External 
Memory).  
 
Modifications made in the configuration tabs (Sensor / Datalogger) automatically update the 
corresponding bits in the EEPROM or in the register file. The bit level impact of modifying the settings is 
displayed in this tab.    
 
Only the Register File is accessible for write operation to avoid any bad manipulation in the EEPROM. 
(Register files are cleared after resetting the MLX90129). Storage memories can be read. The “initialize” 
button will write 0xFFFF values to the EEPROM or External Memory..  
 
/!\ WARNING: The external memory can only be read if the correct memory settings are programmed in 
the “Datalogger Application” tab 
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4.6. Demo 

The “Demo” tab allows for easy demonstration of EVB90129 sensing features. It is important to note that 
the sensors are for demonstration only and are not calibrated or set for granular measurement. Sensor 
configurations are preprogrammed and available by dragging and dropping the sensor icon on the free 
sensor area. There are configurations available for: 

� MLX90129 Internal temperature sensor (thermometer)  
� External temperature sensor (thermometer) 
� External trimmer sensor (gauge)  
� External light sensor (bulb) 

 
 Once the icon has been dragged and dropped in the sensor area, the demo can be started by pressing 
“Start” button and stopped by pressing the “Stop” button. 
The demo reads sensor values continuously and provides a graphical display of the value with an 
animated picture. The sensor configuration can be removed by pressing the “Remove” button.   
 
/!\ NOTE: The given temperature is a rough estimation because the sensors are not calibrated. 
/!\ NOTE: The bulb will only light  if a direct light is applied very close to the sensor.   
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5.Step by step examples 
 
In the following examples, step by step instructions provide simple instructions to experience the sensor 
tag and datalogging features of the EVB90129. Start by clicking on the RFID configuration tab after 
ensuring the reader is connected.  

5.7. Sensor tag 

This example application selects the internal temperature sensor for sensor 0 and the trimmer for sensor 
1, then reads sensor values by RFID at a single point in time.  
 

Actions Pictures 

Select “Sensor Configuration” tab  

 
Apply the default configuration for the Internal temperature 
sensor for sensor 0 

 

 
Select sensor 1  

 
Apply the default configuration for the external trimmer 
sensor for sensor 1 

 

 
On the EVB90129, connect the trimmer sensor  to the 
MLX90129 by setting the correct jumpers  

     
Select “Sensor Tag Application” tab  

 
Select “Sensor 0” and “Sensor 1” boxes and write 500 ms for 
the sensing period  

 

 
Press “Read”  

 
Select “Yes” for the question “Would you like to proceed?” in 
order to load configuration into the MLX90129 

 

 
Ensure the application is running. If not – go back to the first 
step. 
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Press “Stop” to stop the application  

 
Select save data  

 
Name and save the file  

 
Open the saved data file (in Excel, for example) and create a 
graph 

 

5.8. Datalogging 

This example of the datalogging application selects the internal temperature sensor for sensor 0 and 
configures the MLX90129 as a datalogger to save temperature data every second for a period of 10 
minutes. Data are saved with a timestamp in the external memory. 
 

Actions Pictures 

Select “Sensor Configuration” tab  

 
Apply the default configuration for the Internal temperature 
sensor for sensor 0 

 

 
Select “Datalogger Application” tab  

 
Select Sensor 0 and Timestamp  

 
Select External Memory for the data destination  

 
Press the button “EVB90129 External Memory Default” in the 
External memory configuration area.   

 

 
Select “s” to log data every second  

 
Data will be saved 600 times (every second for ten minutes). 
Type in the number 600 in the Log data field 

 

 
Select the sub tab “ Application”  
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Press the “Start Datalogging” button   

 
Select “Yes” for the question “Would you like to proceed?” in 
order to load configuration into the MLX90129 

 

 
As requested by the warning message, the battery has to be 
plugged on the EVB90129 and the “VDD Selector” jumper 
has to be set on BAT. 

 

     
 

 
As requested by the warning message, the “SS Selector” 
jumper has to be set between SS_29 and SS_MEM.   

 

 
 

 
Ensure the application is running  

 
Click the “Read Current Address” button to display the 
progress of the operation. 
 

 

 
After 10 minutes, click the “Read Current Address” button to 
make sure the datalogging has ended (the number is no 
longer increasing).  

 

 
Click the “Read Data” button to load the logged sensor 
values from the external memory. 

 

 
Data can be saved by pressing the button “Save Data”  

 
Name and save the file.  

 
Open the saved data (in Excel, for example) and create a 
graph 
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6.Trouble shooting notes 
 
Troubleshooting Checklist.  
 
A warning message indicates the reader is not connected:  

� Are the drivers correctly installed? => Check the Windows pop up after the reader has been 
plugged in. 

� Confirm the COM port number is between 0 and 9. => If not, modify the COM port number by 
following the procedure described in Chapter 2 of this document  

� Is there other software using this COM port? (for example, if you already have the Proxima RF 
reader demo running, the COM port is already in use) => If yes, close the other application. 

 
EVB90129 does not answer or a warning indicates, “No Tag Response”:  

� Is the correct MLX90129 device selected? => Check  Menu Tools/ Device 
� Is the MLX90129 correctly powered? => Check to see if you have clicked the “Disconnect field 

supply” option on the Sensor configuration tab. If so a battery has to be used to power the 
MLX90129. 

 
Sensor tag application is not reading data:  

� Is the correct MLX90129 device selected? => Check  Menu Tools/ Device 
� Is the MLX90129 configured with correct settings? => Load settings through Menu Project/ Load 

to MLX90129. 
� Are the settings correct? => Try the application with default settings provided.  
� Are the external sensor connections enabled? => Check the EVB91029 jumpers (refer to page 4 

of the EVB90129 user manual) 
 
No data is being logged  

� Are the threshold settings correctly set? => Check the tab “Sensor Configuration” tab. 
� Is the external memory enabled and connected? => Check the EVB91029 jumpers.                   

(refer to page 4 of the EVB90129 user manual) 
 

7. Contact Information 
Further information can be found in the MLX90129 datasheet. If further documentation is required please 
refer to the Melexis website, www.melexis.com.  For additional information contact: 
 

Melexis Proxima RF™ 

rfid@melexis.com support@proximarf.com 
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